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Read This First 

 
This document is designed to help with the problems that may occur while the MLogger is 
operating.  Some problems will require troubleshooting with a Terra SLS tech.  For tech 
support, call the Terra SLS office phone number during normal business hours, (970) 243-
3044, or call the After Hours number outside of normal business hours, (970) 261-8959.  If 
cell service is poor, an email can be sent to operations@terrasls.com.  If nobody is available 
to answer the call and a call back is desired, then leave a voicemail with your first and last 
name, company name, phone number, the issue with the equipment or software, and the 
serial number of the MLogger in use (this can be found on the sticker under the handle of the 
MLogger). 
 
Please remember that the MLogger is essentially a computer with a Hard Drive, Processor, 
and Wireless Router and is therefore subject to basic computer malfunctions.   

 
*NOTE- As with all computers and routers, sometimes they need to be rebooted.  For 
connection type issues, the first thing that should ALWAYS be tried before calling a field 
supervisor or Terra SLS is reboot the MLogger, the PC or, if it is an internet problem, then 
reboot the router.    

 
Reference the following pictures when attempting to diagnose an MLogger problem.  
Knowing where the major components of the MLogger are when working with Terra SLS tech 
support will help when troubleshooting.  Before attempting to fix any internal problems, 
please get familiar with the components inside the box.   

 
The following pictures are of MLogger Models TGC “Red Box”, TGCc “Yellow Box”, and CHO 
“Green Box”, and are current up to the date this manual was written.  The Green Box and 
Yellow Box will have all the same major components as a Red Box but will also have extra 
sensors: an infrared CO2 sensor, an electrochemical H2S sensor, and an O2 sensor (Green Box 
only).  The H2S and CO2 sensors are set up differently in the Green and Yellow Boxes.  The 
Green and Yellow Boxes will also have an extra jar filter, flowmeter and exhaust port.  With 
the extra components, there are a few minor plumbing differences.  The MLogger Model TG 
“Blue Box” will not have the chromatograph or extra sensor components, such as the Carrier 
Air Gauge and Regulator, Chromat Column, GC Zero, Carrier Air Filter Housing, 24v pump, 
Chromatograph Valve Manifold, GC Filament, CO2 Sensor, H2S Sensor, and O2 Sensor. 

 
Please take the time and read through this manual and get familiar with the components of 
the MLogger.  This information is essential to smooth operation of the Terra SLS equipment 
and can save time, energy, and money when the equipment is used properly and efficiently. 
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Figure 2 
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Figure 3 
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Figure 4 
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Figure 5 
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Figure 6 
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Figure 7 
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Figure 8 
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Figure 9 
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Figure 10 
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Figure 11 
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Diagram 1 
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TControl Can’t Connect to the MLogger 

 
1. The computer is connected to a wifi network.  Make sure that the logging computer is not connected to a wifi network.   

a. If the computer is connected to a wifi network, disconnect from it and then connect with TControl.  Once 

TControl connects, then connect the computer back to the wifi network. 

 TControl connects to the IP address on the MLogger through the ethernet cable.  If the computer is already 

connected to a wifi connection to a different network, then it is already connected to a different IP address 

and TControl will be unable to connect to the IP address on the MLogger.   

2. The MLogger may not be “Alive”.  Verify that the “I’m Alive“ light (upper green light on front panel) is flashing every 4-7 

seconds. 

a. If the MLogger was recently turned on, it may still be booting up.  The light should start flashing within 5-8 min.  

Try connecting again once this light starts flashing. 

b. If the light is not flashing, reboot the MLogger by turning its power switch off for a few seconds and then 

turning it back on.  The light should start flashing within 5-8 minutes. 

i. If the I’m Alive light doesn’t start flashing again, try to connect with TControl anyways; the LED may be 

burned out or disconnected. 

3. The network connections may be connected incorrectly.  Verify that the logging computer is directly connected to a 

blue LAN port on the MLogger and that the internet (optional) is connected to the red WAN port on the MLogger. 

a. There should not be any other connections in between the logging computer and the MLogger. 

b. If this networking was not connected correctly, then make the corrections and then reboot the router inside of 

the MLogger by disconnecting the power cable to the router (fig. 10) and leaving it disconnected for 2 minutes.  

Then, plug the power back in and allow a minute or so for the router to boot up and then try connecting again. 

4. The logging computer may have an issue obtaining an IP address.  Reboot the logging computer. 

5. There may be a software related issue with the MLogger.  Reboot the MLogger. 

6. The LAN port may be bad.  Try a different blue LAN port on the MLogger. 

7. There may be a bad connection between the logging computer and the MLogger.  Disconnect and reconnect both ends 

of the ethernet cable that is connecting the logging computer to the MLogger. 

8. The ethernet cable may be bad.  Try a different ethernet cable to connect the logging computer to the MLogger. 
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9. There may be a bad connection between the router and the processor inside the MLogger.  Disconnect and reconnect 

both ends of the green ethernet cable inside of the MLogger that connects the router to the processor. 

 

 

10. There may be an issue with the router inside the MLogger.  Check for lights on the router. 

a. Typically, the green, the red, and 1 of the blue ethernet cables should have lights. 

b. Cables that are plugged into the router that are being used should have a solid yellow light and a green flashing 

light.  Since the logging computer should be the only thing connected to the blue LAN ports on the outside of 

the MLogger, only one of the blue cables connected to the router should be lit up.  If the lights are off, then 

i. Disconnect and reconnect the power cable to the router (fig. 10). 

ii. Disconnect and reconnect the ethernet cables that are plugged into the router. 

iii. Try connecting the ethernet cable from the logging computer directly into the router where one of the 

blue cables is connected. 

 

 

11. The logging computer may be set to a static IP.  Verify that the logging computer is set up to obtain an IP address 

automatically (DHCP) and is not set to a static IP. 

a. In Windows 11, left click on the computer’s Start menu, , and then select Settings, . 

b. Select Network & Internet from the list on the left side of the window. 

c. Select Ethernet from the options on the right side of the window. 

d. The IP Assignment should be set to Automatic (DHCP).  If it is not, click the Edit button and select the 

Automatic (DHCP) option from the dropdown menu. 

 Changing this in older versions of Windows can be different.  Use the internet for help. 
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12. The wrong IP address may have been entered in TControl when connecting.  Be sure to use the address, 192.168.123.3. 

13. TControl may be out of date.  Check for updates and install if necessary.   

a. Open TControl and go to the Help menu and select Update TControl.   

b. There is a USB memory stick included in every MLogger with the latest version TControl. 

c. Go to https://www.terrasls.com/download/ to check for newer versions. 

14. Advanced Troubleshooting.  Try opening a command prompt window (   type CMD  hit ENTER).  

Once the command prompt window is open, type ping -t 192.168.123.254 to continuously ping the router in the 

MLogger.  This should produce a series of response times that should be mostly 1 ms (1 millisecond) or <1 ms.  If the 

response is “Destination Host Unreachable” or “Request Timed Out” or “General Failure”, then  

a. Try reseating both ends of the ethernet cable that is connecting the computer to the MLogger. 

b. Try a different blue LAN port on the MLogger. 

c. Try a new ethernet cable. 

d. Try rebooting the logging computer. 

e. Try rebooting the router inside of the MLogger by disconnecting the power cable to the router (fig. 10) and 

leaving it disconnected for 2 minutes.  Then, plug the power back in and allow a minute or so for the router to 

boot up and then try connecting again. 

If the ping times are good, then hit Ctrl+C to stop the pings.  Then, type ping -t 192.168.123.3 to continuously ping the 

processor in the MLogger.  This should produce a series of response times that should be mostly 1 ms (1 millisecond).  If 

there are a lot of responses that are more than 1 ms, then 

a. Locate the green ethernet cable inside the MLogger (there is only one) and disconnect and reconnect both ends 

of that cable.  One end will be connected to the router and the other end will be connected to the processor.  

See Step 9. 

15. Anti-virus or Firewall software may be interfering.  Make sure that any Anti-virus and Firewall software is disabled or set 

to allow TControl access to the Internet.  TControl needs to have TCP/IP capability to talk with MLogger.  The MLogger’s 

router requires ports 20, 21, 22, 23, and 5001 in order to work properly. 

16. There may be an issue with the network.  When trying to connect remotely through a satellite, make sure your satellite 

modem or router is passing ports to the MLogger.  The MLogger’s router requires port 20, 21, 22, 23, and 5001 in order 

to work properly. 

17. There may be too many connections.  Check the number of network connections. There may be more than one local 

connection enabled and causing a conflict.  Disable any unnecessary local connections, reboot the computer, and try 

connecting again. 
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TControl Can’t Connect to the MLogger Remotely 

 
1. There may be a network or firewall issue.  Some networks have strong firewall and antivirus programs that may need to 

be disabled.  Check with the IT department in the office and ask them to allow ports 20 through 23 and port 5001 to the 

computer.  In most cases there is no problem allowing this and the integrity of the network is safe. 

2. The modem may need to be configured.  If the network does not have a designated server and instead consists of a 

satellite and its modem, check the configuration of both.  The satellite may have a firewall blocking some ports or its 

modem may not be passing the prescribed ports 20 through 23 and 5001.   

Can’t Access the Internet Through the MLogger 

 
1. The internet cable may be unplugged.  Connect the internet cable to the Red WAN port on the MLogger. 

2. The internet service from the provider may not be working.  Verify that the internet cable is providing internet.   

a. Disconnect the internet cable from the Red WAN Port on the back of the MLogger and connect it directly to the 

logging computer.  If the computer does not connect to the internet, contact the internet service provider.  If it 

does connect to the internet, then plug the internet cable back into the Red WAN port on the MLogger. 

3. The router that is supplying the internet may need to be rebooted.  Reboot the router that is supplying the internet. 

4. The router inside the MLogger may need to be rebooted.  Reboot the router inside the MLogger. 

a. Disconnect the power cable to the router (fig. 10) and leaving it disconnected for 2 minutes.  Then, plug the 

power back in and allow a minute or so for the router to boot up and then try connecting again. 

5. The Red WAN port may be broken.  Verify that the Red Ethernet cable on the MLogger’s router has 1 solid yellow light 

and one flashing green.  If not, unplug the Red Ethernet cable from the router and plug the internet cable directly into 

that connection.   
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Changing a Filament  

 

                                          
 
 
 

1. For detailed instructions, go to TControl’s Help menu  Manuals  Changing Filaments. 
 
TIPS 

1. When removing the CCD filament from the detector block, the o-rings can stick in the block and do not get removed 

with the filament.  Ensure that both o-rings (one for the Compensator and one for the Detector) get removed.  

Conversely, when installing the new CCD filament, ensure that both o-rings are in place on the filament before securing 

to the block. 

                       

2. When removing the red cap on a new CCD filament, be sure to remove it gently.  Removing the cap in a harsh manner 

can loosen the detector from the board, ruining the filament before it ever gets used. 

 

CCD Filament 
(Catalytic Combustion Detector) 

TCD Filament 
(Thermal Conductivity Detector) 

O-rings 
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Reseating Phoenix Connectors 

 
Reseating the Phoenix connectors on the I/O board is one of the most common troubleshooting tasks.  Reseating these 
connectors can help with low voltage or erratic voltage issues, chromat valve issues, I’m Alive light or booting issues, PID 
Controller issues, etc.   
 

Left Connector:  Mainly attributed to resolving issues with the Chromat Valves sticking, the I’m Alive light not blinking, or 

the PID Controller fluctuating outside of a normal range. 

Middle Connector:  Mainly attributed to resolving low voltage or erratic voltage for the CCD filament and booting issues. 

Right Connector:  Mainly attributed to resolving low voltage or erratic voltage for the TCD and GC filaments. 

 

To reseat a connector, grab the entire green connector and wiggle it away from the board (approximately 1/8” away from 

the board is sufficient) and then push the connector back on.  Try not to fully remove the connector from the I/O board.  

Repeat this step 2 or 3 times to ensure a clean connection. 

    

 The connector should be pulled away from the board, not in a downward direction. 

 There are no fasteners that hold the connector in place but the connection should be tight. 

 If the connector is pulled completely off, be sure that it gets reconnected correctly and not offset by a pin. 

 

 Fully disconnecting the Middle Phoenix connector while the MLogger is turned on could result in a Nuke. 

 If the connector seems to break into pieces, that is fine.  The connectors are segmented and the segments are held 

together by tongue-and-groove fasteners.  Reconnect them and then push the connector back on. 

 The wires going into the connector can also be adjusted or moved around to help correct these same issues.  The 

screws may also be tightened (a 3/32 flathead works best).  The labels on the I/O board, just above the Phoenix 

connectors, will indicate the function for each wire. 

Chromat Valves CCD TCD & GC 

BAD 
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CC, TC and/or GC Filament Voltage Issues 

 
1. The filament may have a bad connection.  Reseat the Molex connector attached to the filament.  The Molex 

connector is the white electrical plug attached to the filament.  Unplug the connector from the filament and reattach. 

NOTE: Take extra care when unplugging the Molex connectors.  DO NOT pull the plug off by the wire as this can 

worsen the current problem or create a new problem. 

2. The filament may not be getting good power from the I/O board.  Reseat the corresponding green Phoenix 

connector on the I/O board (pg. 21).  

3. The filament may be bad.  Replace the filament.  For detailed instructions, go to TControl’s Help menu  Manuals 

 Changing Filaments. 

4. The flow on the TG flowmeter may be out of range.  If necessary, adjust this flowmeter to 0.5 SCFH.  Too much or 

too little flow will affect the filament voltages. 

5. The mounting screws for the filament may be loose, causing a leak.  Ensure all mounting screws are firmly snug. 

6. There could be an issue with the exhaust lines.  Verify that all exhaust lines are attached and secure to the exhaust 

ports on the rear panel of the MLogger and that they are ran outside of the trailer so that the empty Zero Air and 

Carrier Air vacuum ports cannot vacuum in what is being exhausted out.   

7. There may be an issue with the corresponding Potentiometer (fig. 1) for the filament in question.  Verify that the 

wires on the back side of the potentiometer are still in place and not broken off.  If there are any loose solder joints, 

then a soldering iron is required for this repair.  The MLogger should be replaced. 

8. Outside electrical interference could be affecting the voltages.  Try moving all electronics 1 ft away from the 

MLogger. 

9. “Dirty” power supplied to the MLogger could be affecting the voltage.   

a. Plug the MLogger into a battery backup if one is not already in use.   

b. If the MLogger is already plugged into a battery backup, try a different outlet on the battery backup. 

c. The battery backup might be bad.  Remove the battery backup and plug directly into the wall outlet. 

Total Gas Value Is Stuck 

 
1. In TControl, go to the Tools menu and select Filaments Reset and then follow the dialog windows that appear. 

2. If this is a persistent issue, 

a. It could be due to the gas concentration consistently being within the range of the CCD and TCD switchover 

thresholds of 480u and 440u.  Try lowering the thresholds.  Go to Setup  Gas Detector tab  change CCD 

Threshold to 280 and TCD Threshold to 240  Apply and OK. 

b. It could be due to a bad filament.  Try replacing the CCD filament first as it is the most common to go bad. 

c. It could be a software issue.  Try nuking the MLogger when there is time. 
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Filament Baseline Voltages Are Drifting After Zeroing Them 

 
1. This can be caused by a temperature change in the atmosphere.  The MLogger has a heated detector block that houses 

the filaments.  This block is kept at a steady 120 degrees Fahrenheit to help keep the sample gas at a constant 

temperature.  However, even with the heated detector block, the baseline can have a noticeable drift from day to night 

because of temperature change. 

2. The flowmeters on the front panel may be set too high.  Adjust the flows if necessary.  GC (0.5 SCFH), TG (0.5 SCFH), 

Main (5.0 SCFH), CO2 (0.2 SCFH). 

3. The filament may not be getting good voltage from the I/O board.  Reseat the appropriate Molex connector on the 

filament and reseat the corresponding Phoenix connector (pg. 21). 

4. The filament may be bad, even if it is new.  Try replacing the filament.  For detailed instructions, go to TControl’s Help 

menu  Manuals  Changing Filaments. 

5. The PID Controller (fig. 5) may have an issue.  The display should read 120 degrees Fahrenheit, or close to it.  If the 

display is blank or is fluctuating more than 2 degrees from 120, one of the wires connected to the base of the controller 

may have a loose connection and the setscrew for that wire may just need to be tightened.  The MLogger should be 

turned off if attempting this repair. 

6. There may be an issue with the exhaust lines.  Verify that all exhaust lines are connected and secure and are not 

obstructed.  In cold weather, the exhaust lines can freeze, causing backpressure into the system and will affect sample 

flow.  TERRA SLS suggests running all exhaust lines into a single pipe or hose inside the trailer and then running the hose 

or pipe outside to reduce the risk of freezing. 

100% Methane Test Gas Does Not Reach 10,000 Units 

 
1. This could just be an issue with the previous calibration.  Per the Total Gas Calibration manual, as long as the TCD 

voltage is able to reach above 6.5v, then it should be fine.  The calibration just needs to be adjusted. 

2. There could be an issue with the exhaust lines.  Verify that all exhaust lines are connected and secure and are not 

obstructed.  The Main Exhaust line, in particular, must be connected to provide enough backpressure for a good 

sample.  The total gas units may be off by 2000 units or the voltage for the TCD may only reach 4-6 volts if this line is 

disconnected or loose. 

3. The mounting screws for the filaments may be loose, causing a leak.  Ensure all mounting screws are firmly snug. 

4. The filament may not be getting good voltage from the I/O board.  Reseat the Molex connector on the TCD filament and 

reseat the Right Phoenix connector (pg. 21). 

5. The TCD filament may be bad.  Replace the TCD filament.  For detailed instructions, go to TControl’s Help menu  

Manuals  Changing Filaments. 
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6. The test gas bottle may be empty.  Verify that the test gas bottle has more than 10 PSI.   

7. There could be a leak in the internal plumbing.  Perform a quick leak check.  Cover the Sample In port, Chromat Exhaust 

port, and the Detector Exhaust port with your fingers and observe the three different flowmeters.  If all the beads fall 

to zero, then there are no leaks.  If any or all beads remain above zero, then there is a leak somewhere from the Sample 

In port to the exhaust.  Use the sample flow chart to trace the MLogger plumbing and check for any cracks, kinks, holes, 

or loose polyflow fittings. 

1% Methane Test Gas Does Not Reach 100 Units 

 
1. This could just be an issue with the previous calibration.  Per the Total Gas Calibration manual, the CCD voltage at 1% 

methane should normally be between 1.01v and 1.35v.  Check the Calibration number for the CCD Voltage at 1% gas.   

2. There could be an issue with the exhaust lines.  Verify that all exhaust lines are connected and secure and are not 

obstructed.   

3. The mounting screws for the filaments may be loose, causing a leak.  Ensure all mounting screws are firmly snug. 

4. The filament may not be getting good voltage from the I/O board.  Reseat the Molex connector on the TCD filament and 

reseat the Right Phoenix connector (pg. 21). 

5. The CCD filament may be bad.  Replace the CCD filament.  For detailed instructions, go to TControl’s Help menu  

Manuals  Changing Filaments. 

6. The test gas bottle may be empty.  Verify that the test gas bottle has more than 10 PSI.   

7. There could be a leak in the plumbing.  Perform a quick leak check.  Cover the Sample In port, Chromat Exhaust port, 

and the Detector Exhaust port with your fingers and observe the three different flowmeters.  If all the beads fall to 

zero, then there are no leaks.  If any or all beads remain above zero, then there is a leak somewhere from the Sample In 

port to the exhaust.  Use the sample flow chart to trace the plumbing and check for any cracks, kinks, holes, or loose 

polyflow fittings. 

a. If the leak check indicates a leak, a rare possibility could be that the CCD filament is missing an o-ring.   

i. Remove the CCD filament from the detector block and check the Detector and Compensator components 

of the filament; they should both have a black rubber o-ring.  If one is missing, it may be stuck in the 

detector block.  If the missing o-ring is not found, replace the filament. 
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Filament Voltage Stuck On Negative Value 

 
1. The potentiometer for the filament in question may not be turned far enough to the right.  When the potentiometer is 

turned all the way to the left until it stops, it should take between 4 and 7 turns to the right to achieve 0.05v.   

2. The filament may not be getting good voltage from the I/O board.  Reseat the Molex connector on the filament and 

reseat the corresponding Phoenix connector (pg. 21). 

3. The filament may be bad.  Replace the filament.  For detailed instructions, go to TControl’s Help menu  Manuals  

Changing Filaments. 

4. There may be an issue with the configuration.  If the CCD is disabled in the System tab of the Setup menu and the TCD 

voltage is negative, then the CCD voltage will display -0.195v and will not adjust.  Enable the CCD. 

Main Flow Won’t Adjust Higher Than 2 SCFH 

 
1. The Sample Line or Main Exhaust line may be restricting flow.  Remove the Sample line and the Main Exhaust line 

from the back of the MLogger.  With these lines disconnected, the Main flowmeter should be able to adjust up to 7 

SCFH or higher.  If this is achieved, then the IT pump is healthy.   

a. If the 7 SCFH cannot be reached with both lines disconnected 

i. Replace the filter in the Vacuum Jar on the front panel.  The filter may be too dirty and will restrict flow. 

ii. Open the MLogger and inspect all inside lines for kinks. 

iii. Open the MLogger and inspect all the inside lines for moisture.  If moisture is found in the lines, it should 

be cleaned out.  Remove, clean, and reinstall one line at a time to minimize risk of reattaching lines 

incorrectly.  If there is moisture in the Main flowmeter, then it will need to be cleaned out too.  Remove 

the plug from the top of the flowmeter and use pipe cleaners to remove the moisture. 

iv. Open the MLogger and inspect the IT pump (fig. 7).  Verify that all 4 polyflow lines are attached and that 

the black diaphragms are still in place and have not been blown off. 

b. If the 7 SCFH could be reached with both lines disconnected 

i. Reconnect the Main Exhaust line.  If the flow dropped significantly, then troubleshoot the exhaust line 

for obstructions.   

ii. If the flow did not drop after reconnecting the Main Exhaust line, then reconnect the Sample line.  If the 

flow dropped significantly and a value of 4-5 SCFH cannot be reached, then troubleshoot the sample line 

for obstructions. 

2. The bead in the Main flowmeter may be stuck. 

a. Remove the plug from the top of the flowmeter and use pipe cleaners to free the bead. 

b. Or try this- Turn the unit upside down and tap on the flowmeter to free a possible stuck bead. 
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Carrier Air Pressure Has Dropped and Won’t Adjust To A Higher PSI 

 
1. The 15-micron filter may be clogged.  Disconnect the Vacuum line from the 15-micron Filter Housing.   

 

a. If the Carrier Air Pressure still cannot be adjusted higher 

i. Inspect the line connecting the 24v pump to the Pressure Regulator and the line from the Pressure 

Regulator to the Pressure Gauge and the line from the Pressure Regulator to the Chromat Manifold for 

moisture.  If moisture is present, remove, clean, and reinstall one line at a time to minimize risk of 

reattaching lines incorrectly. 

ii. The Pressure Regulator may be bad.  The MLogger will need to be replaced. 

b. If the Carrier Air Pressure can be adjusted higher, then replace the 15-micron filter. 

i. Remove the Filter Housing by loosening both smaller poly flow fittings with a 7/16” wrench. 

ii. Open the Filter Housing using two 9/16” wrenches on opposite ends.  When the housing comes loose, be 

careful not to lose the small spring located within (see picture below).   

 

     

iii. Replace the filter and make sure the number “15” is showing face up when placed inside the housing, 

followed by the spring, and then the top will screw back into place. 

iv. Tighten the housing with the 9/16” wrenches, attach the Filter Housing back to the Carrier Air port 

bulkhead on the rear panel using the 7/16” polylow fitting, and reattach the Vacuum line. 

2. The 24v pump may be dead.  Inspect the 24v pump (fig. 7) and verify that it is vibrating.  If it is not, then the pump may 

be dead.  Replace the MLogger. 

Vacuum Line 

Filter Housing 

Replacement 
Filter 
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Chromatograph Won’t Display Any Gas Peaks 

 
1. The voltage may be too negative to read gas.  Re-Zero the GC filament and try another chromatograph run.   

 For detailed instructions, go to the Help menu in TControl  Manuals  Zeroing Filaments. 

2. The scale may be zoomed too far out to see the peaks.  If the y-axis scale on the graph is set to 0-100, left-click 

anywhere inside the graph to change the scale to a Curve Zoom (or “best fit”) scale.  

3. The bead in the GC flowmeter may be stuck at the bottom, restricting flow.   

a. Verify that the ball valve is set to Rig instead of Test Gas. 

b. Tap on the flowmeter with the back of a screwdriver to try to free the bead.  Turning the MLogger upside down 

may help. 

4. The chromat valves may not be getting enough voltage from the I/O board to open and close properly.  Reseat the 

Left Phoenix connector on the I/O board.  Review CC, TC and/or GC Filament Voltage Issues, Step 2. 

5. The chromat valves may be stuck. 

a. In TControl, go to the Setup menu  Chromat tab  click the Stop Current Run Now button. 

b. Open the Setup menu again  Chromat tab  change the Run Time from 5 to 0.25  click the Start 

Continuous Runs button.   

 The valves will now try to open/close every 15 seconds.  A “Swoosh Detection” window may appear.  This is 

normal and can be ignored during this operation. 

c. Connect a bottle of 1% Methane to the Test Gas port on the front panel, turn the ball valve from Rig to Test 

Gas, turn the bottle on, turn the GC flowmeter up to 0.5 SCFH. 

 Using the test gas is not necessary but it adds a great visual indicator for when the valves start working in 

later steps. 

d. Reseat the Left Phoenix connector on the I/O board.  Review CC, TC and/or GC Filament Voltage Issues, Step 2. 

e. Continuously tap on the chromat valves with the back of a screwdriver to attempt to knock the valves loose.   

 This may take a couple of minutes to work.  Once a gas peak can be seen in the chromat graph, move to 

the next step.  If a gas peak does not show after several minutes of performing this step, then the MLogger 

should be swapped out.   

f. Once a gas peak can be seen in the chromat runs, turn the bottle off, turn the ball valve from Test Gas to Rig, 

adjust the GC flowmeter down to 0.5 SCFH. 

g. In TControl, go to the Setup menu  Chromat tab  change the Run Time from 0.25 to 1  click the OK 

button.   

 This will allow enough time for the rest of the methane left in the column to work its way out. 

h. Once the 1 minute run is complete, open the Setup menu again  Chromat tab  change the Run Time from 1 

to 5  click the OK button. 
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6. The GC filament may be bad.  Replace the GC filament.  For detailed instructions, go to the Help menu in TControl 

 Manuals  Changing Filaments. 

7. The 24v pump may be dead or too restricted to inject the sample into the chromat column.  Verify that the Carrier 

Air Pressure Gauge is still showing more than 5 PSI.  If it is not, review Carrier Air Pressure Has Dropped and Won’t 

Adjust To A Higher PSI.   

All 5 Peaks Are Not Showing Up In A Chromat Calibration Run 

 
1. The Carrier Air Pressure may be too low.  Increase the pressure by 2-3 PSI and try again.  Keep adjusting as needed. 

2. The Run Time may be too short.  In TControl, go to the Setup menu  Chromat tab.   

a. If the Run Time is set to a value that is less than 5, then change it to 5, click OK, and try the calibration again. 

b. If the Run Time is set to the default value of 5, then change it to 6 or higher, click OK, and try the calibration 

again. 

Chromatograph Peaks Appear With No Baseline 

 
1. The voltage may be too negative.  Re-zero the GC filament and try another chromatograph run. 

 For detailed instructions, go to the Help menu in TControl  Manuals  Zeroing Filaments. 

Chromatograph Sparkline Appears Erratic or Noisy 

 
1. The GC filament could be getting bad voltage from the I/O board. 

a. Reseat the Molex connector on the GC filament.  Review CC, TC and/or GC Filament Voltage Issues, Step 1. 

b. Reseat the Right Phoenix connector on the I/O board (pg. 21). 

2. The GC filament may be bad.  Replace the GC filament.  For detailed instructions, go to the Help menu in TControl 

 Manuals  Changing Filaments. 

3. Outside electrical interference could be affecting the voltages.  Try moving all electronics 1 ft away from the 

MLogger. 

4. “Dirty” power supplied to the MLogger could be affecting the voltage.   

a. Plug the MLogger into a battery backup if one is not already in use.   

b. If the MLogger is already plugged into a battery backup, try a different outlet on the battery backup. 

c. The battery backup might be bad.  Remove the battery backup and plug directly into the wall outlet. 

5. The effect seen could be due to recycled gas.   

a. Verify that all exhaust lines are connected and secure (3 lines for a Red Box and 4 for a Green/Yellow Box). 

b. If a line is attached to the Carrier In port on the rear panel, disconnect it; this port should be left open. 
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Chromatograph Baseline Wanders 

 
1. The effect seen could be due to recycled gas.   

a. Verify that all exhaust lines are connected and secure (3 lines for a Red Box and 4 for a Green/Yellow Box).  If a 

line was loose or disconnected, it may take more than one chromat run to straighten out after fixing the issue. 

b. If a line is attached to the Carrier In port on the rear panel, disconnect it; this port should be left open.  If a line 

was attached to this port, it may take more than one chromat run to straighten out after fixing the issue. 

2. The effect seen could be due to heavier gases than Butane (C4), such as Pentane (C5), are cycling out of the column. 

a. In TControl, go to the Setup menu  Chromat tab  change the Run Time from 5 to 13  click the OK button.  

If heavier gases are in the sample, it may take more than one chromat run to straighten out after fixing the 

issue.  13 minute runs will be required for as long as the heavier gases are present in the sample. 

3. The Chromat Exhaust line may be obstructed.  Remove this exhaust line, blow it out, and reattach it. 

4. Emissions could be getting vacuumed in by the Carrier In port.  Try moving any chemicals or fresh rock samples that 

are close to the MLogger that could be gassing out away from the MLogger.  

WITS Status Keeps Flashing “ERROR” 

 
1. The WITS cable may have a bad connection on either end.  Verify one end of the cable is connected to the EDR and 

the other end is connected to either of the COM ports on the MLogger.  Try reseating the connections also. 

2. The wrong COM port may be selected in TControl.   

a. If the null modem cable is connected to the COM 2 port on the rear panel of the MLogger, then go to TControl’s 

Setup menu  Geolograph tab  set WITS Port to COM 2  click the OK button. 

b. If the null modem cable is connected to the COM 1 port on the front panel of the MLogger, then go to 

TControl’s Setup menu  Geolograph tab  set WITS Port to COM 1  click the OK button. 

3. The null modem cable may be bad.  Try a different null modem cable. 

4. The EDR workstation may not be set up to WITS out to the MLogger.  Call the EDR company and have them set it 

up.   

 The only WITS channels that are necessary for the MLogger to operate are Bit Depth (0108), Hole Depth (0110), 

Pumps 1, 2, & 3 (0123, 0124, & 0125).  All other channels are extra.   

5. The COM port on the MLogger may be bad.  Connect the null modem cable to the other available COM port and 

then change the WITS Port setting in the Geolograph tab of TControl’s Setup menu and then click the OK button. 

6. The WITS Interface may be set incorrectly.  In the Geolograph tab of TControl’s Setup menu, change the WITS 

Interface to Streaming and then click the OK button. 

7. If a Serial-to-USB adapter is being used, it may be bad.  Try a different adapter. 
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8. The issue could be with the MLogger software or another hardware component.   

a. Reboot the MLogger. 

b. Perform a WITS Self Test. 

i. Take the null modem cable and connect one end of it to COM 2 on the rear panel of the MLogger and 

connect the other end of the same cable to COM 1 on the front panel. 

ii. In TControl, go to the Setup menu  Geolograph tab  set WITS Interface to WITS Self Test  click OK.  

The WITS Status “ERROR” should turn to “OK” within 20 seconds if everything is fine.   

a) If the WITS Status does not change to “OK”, then the test failed.  Try a different cable.  If a new 

cable does not help, then reboot the MLogger.  After the MLogger comes back Alive, try the Self 

Test again.  If it fails again, then one of the COM ports has failed.  Use the other COM port or 

change out the MLogger. 

b) If the WITS Status does change to “OK”, then open the Setup menu again  Geolograph tab  

change the WITS Port setting to the other COM port and click OK.  If the WITS Status remains OK, 

then everything with the MLogger and null modem cable is working and the issue will be with the 

EDR workstation.  If the WITS Status changes to “ERROR”, then one of the COM ports has failed.  

Use the other COM port or change out the MLogger. 

iii. If the WITS Self Test was successful, reconnect one end of the null modem cable back to the EDR and set 

the WITS Port in the Geolograph tab to the appropriate port. 

9. The EDR may not be sending Bit Depth (0108) or Hole Depth (0110) in every WITS Packet to the MLogger.  In 

TControl, go to the Tools menu  WITSwiz.  The lower section of the window that pops up will show the WITS tags that 

are being received by the MLogger.  If 0108 or 0110 are not displayed in this section, it was not sent by the EDR.  Call 

the EDR company for help 

       

10. The EDR workstation may need to be rebooted.  Reboot the EDR workstation. 
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I’m Alive Light Not Flashing 

 
1. The MLogger may still be booting up.  If the light under the I’m Alive light (the Hard Drive or HD light) is blinking rapidly, 

then the hard drive may be performing a scan disk and can take up to 15 minutes to complete. 

2. The I’m Alive light may be burned out.  Try to connect with TControl anyways. 

3. The I’m Alive light may not be getting power from the I/O board.  Reseat the Left Phoenix connector (pg. 21). 

4. There may be an issue with power to the Processor board.  Reseat the Middle Phoenix connector (pg. 21). 

5. The MLogger’s internal power supply may be damaged on the DC power side.  Check the fan on the power supply to see 

if it is spinning.  If it is spinning, then the power supply is good, move to the next step.   

   OR     

If it is not spinning 

a. Turn the MLogger off, wait at least 2 minutes, then turn the power back on.   

i. If the fan starts spinning after the power cycle, then the I’m Alive light should start blinking within 15 

minutes, typically between 5 to 8 min. 

ii. If the fan does not budge at all after the power cycle, try one more time.  If it still doesn’t work, replace 

the MLogger. 

iii. If the fan budges after the power cycle but does not start fully spinning, try cycling the power switch off 

and on a few more times (no wait period) to get it working.  If it still doesn’t work, replace the MLogger. 

6. The SD card and/or ribbon cables may have a bad connection.  Reseat the SD card and ribbon cables.  For detailed 

instructions, go to TControl’s Help menu  Manuals  Reseating SD Card and Ribbon Cables. 

7. Advanced Troubleshooting.   

a. Connect a VGC monitor and keyboard to the rear panel of the MLogger. 

b. Cycle the power to the MLogger and observer the MLogger boot up. 

c. If the screen shows a message of “no bootable device”, or “had error”, then the Hard Drive has crashed.  

Replace the MLogger. 

 

 

 

 

Inside MLogger Rear Panel 
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MLogger Keeps Rebooting 

 
1. The CCD voltage may have been negative for too long.  Rezero the CCD filament.  For detailed instructions, go to 

TControl’s Help menu  Manuals  Zeroing Filaments. 

 If the signal continues to drift to the negative and requires continuous adjustment, replace the filament. 

2. The power cable may have a bad connection.  Ensure the power cable is pushed in all the way. 

3. There could be an issue with the SD card, Processor, or I/O board.  Reseat the Left and Middle Phoenix connectors 

(pg. 21) and reseat the SD card and ribbon cables.  For detailed instructions, go to TControl’s Help menu  Manuals  

Reseating SD Card and Ribbon Cables. 

4. “Dirty” power supplied to the MLogger could be causing it to reboot.   

a. Plug the MLogger into a battery backup if one is not already in use.   

b. If the MLogger is already plugged into a battery backup, try a different outlet on the battery backup. 

c. The battery backup might be bad.  Remove the battery backup and plug directly into the wall outlet. 

5. The power supply in the MLogger may be failing.  Replace the MLogger. 

TControl Data Exports Don’t Show All Of The Requested Data 

 
Note: The MLogger records all of the well data on its hard drive.  There are two files that TControl will show the 

progress of.  One is the Log File and is displayed as LF in the status window.  The other is the Chromatograph File and 

is displayed as CF in the status window.  Each will show how large they are, as the well proceeds, by a percentage.  

Once the Log File reaches 100% (roughly 14 days of continuous use), the MLogger will begin to wrap that file and 

start over-writing the data from the beginning of the well.  This will also happen when the Chromatograph File 

reaches 100% (roughly 7 days of continuous use).  After the Log file has wrapped, the data will not exist on the hard 

drive.  This is called a circular buffer, and is used so the MLogger boots up faster. 

 

1. The data might have been overwritten.   

a. If the Depth or Total Gas data is missing, check the LF percentage.  If it is over 100% and the data that is missing 

is over 2 weeks old, then that data has been overwritten.  It is gone for good. 

b. If the chromat data is missing, check the CF percentage.  If it is over 100% and the data that is missing is over 1 

week old, then that data has been overwritten.  It is gone for good. 

2. The Depth Range for the export may have been entered incorrectly.  Try the export again and be sure that the From 

and To values are correct and that that range exists within the data set.  If this doesn’t work, try exporting using the All 

Data option. 

3. The data might not be selected in LAS Options.  In the Export Data window, open LAS Options and verify that all the 

curves that are needed are in the list on the right side of the window.  If they are not, move them there. 
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4. The file may be corrupted.  Delete the local file. 

a. In TControl, click the Disconnect button and close TControl.  When prompted, do not shut down the MLogger. 

b. Open TControl but do not try to connect. 

c. Go to the File menu  File Utilities. 

 This opens a list of all the wells that the computer has been connected to. 

d. Select the file at the very top of the list (this should be the current well file) and then click the Archive button. 

e. Click OK in the next 2 popup windows and then click the Close button. 

f. Close TControl. 

g. Open TControl and click the Connect button. 

h. Once TControl is connected, try the export again. 

  


